Google Workspace
(Gsuite)

All faculty, staff, and students use Google Apps for Education for email as well as calendaring,
Docs, and Drive.

For additional support needs, visit support.google.com.
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Overview

Gmail is Google's email service. Gmail is managed via Google's commercial email servers and can
be checked in real-time on the web. Access to Gmail is available to current faculty, staff, students.
Gmail smart features include:

e Integration of Google Chat, Meet, Calendar, and other Google Workspace products
e The ability to create and manage spaces for ongoing and long-term conversations
e Utilization of writing and intelligent search suggestions

Access

To access Gmail on the web, navigate to gmail.google.com
Note: If you are logged into a personal Google account in the same browser, you may be

redirected to the inbox for that account. See this Help Document to add a second account to your
browser session.

To access Gmail from a mobile device, download the Gmail app from the App Store (iOS devices)
or the Play Store (Android devices).

Note: App State recommends using the official Google Gmail app rather than third-party mail apps
such as Apple Mail.

Help

For tailored assistance with Gmail, contact the Help Desk at
helpdesk@cornerstonephiladelphia.com.

For general assistance, visit Google's Gmail Support Page.



https://support.google.com/accounts/answer/1721977?co=GENIE.Platform%3DDesktop&hl=en
https://support.google.com/mail#topic=
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E-Mail Attachment Limits

Attachment Size Limit

You can send messages up to 25 MB in size. You may not be able to send attachments larger than
25 MB to contacts who use other email services that have smaller attachment limits. If you'd like to
send attachments that are larger than this, you can insert them from GoogleDrive.

Note: As a security measure to prevent potential viruses, Gmail doesn't allow you to
send or receive executable files (such as files ending in .exe).

Sending Attachments Larger than
25MB using Google Drive

Gmail's attachment limit is 25MB, but you can insert files larger than 25MB using Google Drive:

1. At the bottom of the email you're writing, click the Google Drive icon Google Drive Icon to
insert files from Drive.

2. In the “Insert files using Google Drive” menu, you can upload a file to Google Drive from
your device or navigate to a file you've stored in Drive. To send a file already stored in
your drive, click on the file you want to attach.

3. Choose the option to insert as either a Drive link (a link to your original file) or as an
attachment (a copy of your file)

4. Click insert to “insert”.

You can also do this on the Android Gmail app by selecting Insert from Drive from the 3-dots menu.
Gmail then adds a link to your message so recipients can click the link to view your file.

Other Attachment Size Limits

Messages sent using Google Groups (replaced listserv system):



To view Google Groups policies and limits, see this help document: Understanding Groups policies

and limits


https://support.google.com/a/answer/6099642?hl=en#zippy=%2Cmessage-and-posting-limits
https://support.google.com/a/answer/6099642?hl=en#zippy=%2Cmessage-and-posting-limits
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How to Obtain Headers from
Email

Below are step-by-step instructions for displaying email header information within several email
apps.

Gmaill

1. In Gmail, click on the email you would like to view headers for.
2. Click the three-dot three-dot iconthree-dot icon icon next to the Reply button.
3. Select Show Original.

Clicking on show original in the settings menu.Show Original

Mac Mall

1. Open the email.

2. Click on the View menu on the Menu Bar.

3. Select Message, then Long Headers.
Selecting Long Heading from the Message drop-down in the View menu.Selecting Long
Heading from the Message drop-down in the View menu.

Outlook 2011

1. Right-click on the email that you would like to view the headers for (or use Shift +Click)
2. Click View Source.
3. This will open a text file with the Header Information outlook source code.

Outlook 2010



. Open the email.

. Click the File Tab.

. Select Properties.

. The information will be listed under the Internet Headers section out look properties.
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Outlook 2007

1. Right-click the email (or use Shift + Click).

2. Choose Message from the menu.

3. The information will be listed under the Internet Headers Section outlook message
options.

Thunderbird

Select the email.

Click on View.

Click on Headers.

Click on All.

Click the “Forward” button and all header information will appear at the top of the email.

e whH
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| am being redirected when |
try to log into my CAA Gmail
account

If Google redirects you to your CCA log-in or inbox when you try to log into your personal account
OR if Google redirects you to your personal account when you try to log in to your CCA account
your browser history is causing this issue. Clearing the history will fix the issue but this solution is
temporary because the browser history will save the page/site and cause the same problem in the
future.

Internet history, also known as browser history, is a tool or resource in a Web browser that
keeps track of sites and pages that a user visits. Through tabulating URLs, Internet history
facilitates a quick reference or lookup of previously visited pages.

The best solution to this problem is to add a second account:

Log into your CCA account (Log out of your personal account first if you are logged into it.)
Click the Google Apps icon in the upper right-hand corner.

Click Add another account.

Log in with the email address and password of your personal account.

P wWwhH

To switch back and forth between these two accounts, click on the Google Apps icon in the upper
right-hand corner and choose the account you want to view from the list.
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Sending Mail from a
Different Address in Gmaill

This guide will show you how to set up the ability to send mail from a different address in your
Gmail account.

When sending mail from an alternate email address (e.g.,
google@cornerstonephiladelphia.com), the sent mail only appears in the sending account
and NOT in the alternate email account. For example, if user@cornerstonephiladelphia.com
can send mail as google@cornerstonephiladelphia.com, the sent mail only appears in
user@cornerstonephiladelphia.com and not google@cornerstonephiladelphia.com.

For more information, navigate to the Google Support Send emails from a different address

or alias page.

How to Grant Someone "Send As"
Access.

You can send mail from an alternate account when you are within your account by setting up the
Send Mail As feature:

1. Sign in to your Gmail account.

2. Click the Clicking the settings gear icon. in the upper-right and select Settings and the
Accounts and Import tab.

3. Under "Send mail as", click Add another email address you own.

4. In the Email address field, enter the name and alternate email address of the account you
want to send from. Do not select “treat as an alias”.

5. Click Next Step >> and then click Send Verification. Gmail will send a verification
message to the other email address to confirm that you should be able to send mail to it.

6. Locate the message from Gmail. Open it and either click the link contained in the
message or enter the confirmation code in the Accounts section of your Google Apps


https://support.google.com/mail/answer/22370?hl=en
https://support.google.com/mail/answer/22370?hl=en

email settings.

Note: You can also set up delegated access to an alternate account by following the guide here:

Setting up Mail Delegation in Gmail.

How to Revoke "Send As" Access.

IMPORTANT: if you want the ability to revoke "send as" access, you will need to keep the
verification message. There are 2 ways to revoke or terminate the ability to send as another

account:

1. From the account that uses the Send Mail As feature: Go to Gmail Settings, select the
Accounts and Import tab, then click on the delete link next to the account in the Send
Mail As section.

2. From the account that granted access to the other account: Go to the email that
confirmed Send Mail As and scroll to the bottom to cancel the verification.


https://confluence.appstate.edu/x/NgK5
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Overview

Drive is a cloud-based file storage and sharing system with built-in tools for word processing
(Google Docs), spreadsheet creation (Google Sheets), slideshow creation (Google Slides), and other
collaboration and productivity applications. Through our Google Workspace (formerly G Suite)
licensing, every CCA faculty, staff, student, storage space in Drive. Users can share files and
collaborate with other Drive users.

Access

On the web, access Drive by navigating to https://drive.google.com/a/appstate.edu.

Note: If you are logged into a personal Google account in the same browser, you may be

redirected to the inbox for that account. See this Help Document to add a second account to your
browser session.

On a mobile device, access Drive via Google's Drive app, which is available for free in the App
Store (iOS devices) or Play Store (Android devices)

Note: CCA recommends using the official Google Drive app rather than third-party mail apps such
as Apple Mail.

Help

For general assistance, please view Google's Support Page.


https://drive.google.com/a/appstate.edu
https://support.google.com/accounts/answer/1721977?co=GENIE.Platform%3DDesktop&hl=en
https://support.google.com/drive/?hl=en#topic=
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Google Shared Drives

What can you do with Shared
Drives?

Shared Drives is a shared space where teams can easily store, search, and access their files
anywhere, from any device.

Unlike files in My Drive, files in a Shared Drive belong to the team instead of an individual. Even if
members leave, the files stay exactly where they are so your team can continue to share
information and get work done.

Not sure whether to use My Drive
or Shared Drives?

Ask yourself these questions:

e Are the files of interest to most or all members of a particular project shared?
e Do the files share a consistent theme?

A "yes" to both questions means creating a new Shared Drive is a good idea. If the files and folders
are for many different projects, create multiple Shared Drives.

More Information

For more on when to use Shared Drives, see this Guide for Best Practices



https://support.google.com/a/users/answer/9310352?hl=en&ref_topic=9300128
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Phishing Attempt Practices

Phishing Attempt Practices

Below are some practices we all need to adhere by during this time of the year for phishing
attempts.

Reporting Suspicious Emails

1. if an email looks suspicious to you even if the user is an actual cornerstone employee. please
report the email by clicking the spam alert icon that is on the toolbar for emails when you open to
read them.
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2. Make sure to report the email as phishing to google. That way the email can be sent directly into
google's phishing filter. There are three dots in the right top corner on every email click the three
dots and you will see the options to report spam or report phishing. After reporting delete the email
and block the sender.

Note: If the sender is a cornerstone employee. please let me know immediately by
contacting me personally or by the helpdesk email.

Note: in the above screenshot under number 1. There are 3 dots as well. That drop
down menu does not have the report phishing or report spam. Only the 3 dots to the far
right of the screen when you are reading the email. Like in the below screenshot.

image.png

How to spot phishing (common signs)

1. Any email asking for payment, credentials, authorization, or personal data.

2. Urgent request attempts "Immediate action required" your account will be closed. (Only myself
and Jay can close your account for your references)

3. A strange sender address- Check the sender's email address. Which is below once you get an
email you suspect to be a phishing email.
image.png

Conclusion: Please practice these steps because phishing attempts will continue
throughout the year from outside sources.
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Filter Sender to Spam or
Delete (Manual Control)

Note: This is for computer devices use only, not mobile devices.

1. Open an email from the sender

<« B O m & 0O @ D 10f 142 >
test email inbox x e O
o Kenneth Williamson <kwilliamson@cornerstonephiladelphia.com> 10:48AM (0 minutes ago) ¢ €
tome »

(h Reply) (ﬁ Forward)

2. Click the 3 dots at the top of email you want to send to spam or
trash and select Filter messages like these.

= B8 O mW B OO0 &4 m D

&5 Mark as unread
test email inbox » Mark as not important
B Kenneth Williamson <kwiliamson@cornerstonephiladelphia.coms ¢ Add star
tome ~ F5] Create event
= Filter messages like these
) Mute

<<—\ Reply ) (ﬁ Forward>



https://wiki.wearecornerstone.com/uploads/images/gallery/2025-10/image.png
https://wiki.wearecornerstone.com/uploads/images/gallery/2025-10/oymimage.png

3. Once you are in "filter messages like these." You will see the
senders email appear at the top. next click "Create filter."

From kwilliamson@cornerstonephiladelphia.com

To

Subject

Has the words

Doesn't have

Size greater than - MB v

[J Has attachment

Create filter

4. In the "Create Filter" section. Select "Delete It" and optional
choose if you have received more than one email from the same
sender also choose "Also apply filter to matching
conversations". Once you select your filter(s) click "Create Filter."


https://wiki.wearecornerstone.com/uploads/images/gallery/2025-10/SEoimage.png

When a message is an exact match for your search criteria:

Skip the Inbox (Archive it)
Mark as read
Star it

Apply the label: Choose label... ~

o ooo0oog

Forwardit  Add forwarding address

Delete it

&

Never send it to Spam
Always mark it as important

Never mark it as important

0O 00 0d

Categorize as: Choose category... =

&

Also apply filter to matching conversations.

Learn more Create filter

5. This will effectively blocks the sender by moving all future emails
from your inbox straight to "Spam or Trash."

®


https://wiki.wearecornerstone.com/uploads/images/gallery/2025-10/fnMimage.png

Setting up 2- Step
Verification(25V) for your
Google Account



Setting up 2- Step Verification(2SV) for your Google Account

2-Step Verification Setup

1. Log into your google account. Once you are logged in go to the
top right corner next to your initial(s) and click Account. Note:
There are two logos once you sign in with your initial displaying.
Click the one on the actual webpage and not the one displaying
over top of "All Bookmarks"

@ # @

O M (&

Account Gmail Drive
Gemini Docs Sheets
E
Slides Calendar Chat
Meet Vids Forms
®

2. Once you are in your account navigate to the menu on the left hand
side of the screen and click on Security.


https://wiki.wearecornerstone.com/uploads/images/gallery/2025-10/FMNimage.png

Google Account Q_ Search Google Account ®

@ Home See details

[E Personalinfo

@ Data&privacy Recent security activity

B security

Recovery email verified 10:35AM - Pennsylvania, USA >
23, People & sharing
B Payments & subscriptions Signing in with 2-Step Verification was turned on Sep 11 Pennsylvania, USA >
Recovery email added Sep 11 Pennsylvania, USA >

@ About

Review security activity

How you signin to Google

Make sure you can always access your Google Account by keeping this information up to date

@ 2-Step Verification @ OnsincesSep 11 >

3. Once you are on the Security page scroll down to the bottom. You
will see the setup for 2-Step Verification options under How you
sign in to Google. Under how you sign in to Google, you have
different Options on how you want to setup 2-Step Verification for
yourself. You can choose one, or all like it is displayed in the
screenshot below. You can also add More Options at the bottom of
the screenshot as well if you choose too. For more security on your
account. (Exp: Authenticator, BackUp 2-Step Verification, and
Backup codes.)


https://wiki.wearecornerstone.com/uploads/images/gallery/2025-10/6BAimage.png

How you sign in to Google

Make sure you can always access your Google Account by keeping this information up to date

@ 2-Step Verification @ Onsince Sep 8 >
==+ Password Last changed Aug 22 >
»e  Skip password when possible >
0 Google prompt 1 device >
[-]  2-Step Verification phones - >
@ Recovery phone - >
&3 Recovery email _ >

You can add more sign-in options

(:q Passkeys and security keys J [:SE’: Authenticator J (@ Backup 2-Step Verification phones J ( Back

Conclusion: Once you follow the steps after choosing your option(s);
your account will then be prompted to use the 2-Step Verification for
when you login moving forward.



https://wiki.wearecornerstone.com/uploads/images/gallery/2025-10/screenshot-2025-10-01-at-9-13-20-pm.png

